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How to Use this Document
This document is designed to provide you with information that is easy to 
understand and quickly accessible. However, there are several items to keep in 
mind when reading and using this document.

Items to Look For: Description

Button Names and Keyboard 
Shortcuts / Commands

All buttons mentioned in this document have an 
associated keyboard shortcut. These shortcuts 
appear in parenthesis next to the button name and 
appear in bold (identical to the onscreen 
counterpart).

For example: Click the Select (Enter) button.

You can either click the button with the mouse or 
press the key mentioned in parenthesis.

Keyboard Commands There may be instances when you need to press a 
key that does not have an associated button. These 
keys appear between brackets (<>) and are bold.

For example: Press the <F10> key.
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How to Use this Document
Field names If the sentence mentions entering information in a 
field, the field name is italicized and in a contrasting 
font. 

For example: Enter the last name of the Patient in 
the Last Name field.

The only time this is not true is if the field is 
followed by a definition. Then the field name is 
bolded and proceeded by a bullet.

Typing Data in a Field If the sentence mentions entering specific data in a 
field, the data appears in a different font compared 
to a field name.

For example: Type Yes in the Question field.

Specific Screen Action If an action occurs after doing something within the 
application, it is described in italics within 
parenthesis.

For example: Click the Next button. (The Ready to 
Install screen appears.)

Popup Windows Many fields within CPR+ have an associated drop-
down arrow icon. This icon displays a popup 
window of related data that can be selected and 
entered into the identified field.

When this option is available, you will see the 
following text: “Use the associated popup window 
to…”

When you see this text, you can access this popup 
window in two ways: 

• Click the drop-down arrow icon or
• Press the <F10> key while the cursor is in 

that field.

It is important to use these popup windows for 
consistent data entry throughout the program.

Items to Look For: Description
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How to Use this Document
In addition to the above information, there are several note related icons used in 
this document.

Icon Explanation

This icon represents a relevant note regarding the information being 
discussed.

This icon represents an important note that relates to required knowledge for 
a particular task.

This icon represents information that can save you time during a particular 
task.

This icon represents a warning regarding information that must be 
understood before continuing.
CPR+ Palm User Guide 7





 Chapter  1 Getting Started & Configuring 
CPR+ Palm
Congratulations and thank you for your purchase of the CPR+ Palm module. 
With CPR+ Palm, you have access to accurate and timely information essential 
for safe, effective delivery and cost efficient care of your patients. This user guide 
explains some of the basic operations and functionality of this add-on module. For 
more detailed instructions and training, please contact the CPR+ Training & 
Implementation Department or log on to the CPR+ On-Demand Training System 
from the CPR+ Main Menu.

Before using CPR+ Palm, the module must be installed and the application must 
be configured. After reading this chapter, you will be able to:

• Identify how to assign users to use this module.

• Describe the settings contained in the HotSync and ActiveSync interfaces.

• Identify how to install CPR+ Palm on your handheld device and sync 
CPR+ data.
CPR+ Palm User Guide 9



Chapter 1: Getting Started & Configuring CPR+ Palm
 Assigning Users to the Module
Assigning Users to 
the Module

Once the CPR+ Palm module is activated by a CPR+ representative in either 
support or sales, the next step is to assign users the ability (or privilege) to use this 
module on a handheld device (a.k.a. PDA). 

Repeat the above steps for each user that will need access to this module.

Step Action

1 Access an employee’s record from the Database Menu by clicking the 
Employee Data / Security Setup (8) button. (A screen with a list of users 
appears.)

2 Select the user name in the list and then click the Select (Enter) button. 
(The Employee Setup screen for that user appears.)

3 Click the Options tab on the Employee Setup screen.

4 In the Palm User field, select Yes by clicking the drop-down arrow icon.

5 Click the Save (F2) button for this change to take affect for this user.
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Chapter 1: Getting Started & Configuring CPR+ Palm
 Using the Sync Interfaces
Using the Sync 
Interfaces

With the user(s) assigned, the next step is to configure the sync interface and 
determine the amount of data that will be uploaded to the PDA.

Depending on the device, the user will either select HotSync with CPR+ (for 
Palm OS devices) or ActiveSync with CPR+ (for Pocket PC or Windows Mobile 
devices) from the File drop-down menu.

Figure 1-1)  
File Drop-Down PDA 
Sync Options

Depending on the PDA being used, a screen similar to one of the ones shown on 
the next page is displayed after installing the Palm Desktop or ActiveSync software

The corresponding software for Palm OS (Palm Desktop) and Windows Mobile 
OS (ActiveSync) must be installed on your workstation before proceeding. 
CPR+ will use this software to load the module and upload data.

Please refer to your PDA documentation for more information on this software 
and how to install.
CPR+ Palm User Guide 11



Chapter 1: Getting Started & Configuring CPR+ Palm
 Using the Sync Interfaces
Figure 1-2)  
ActiveSync Settings 
Screen

Figure 1-3)  
HotSync Settings 
Screen

You must have install privileges on your workstation to install the client 
software. Please refer to your Windows OS documentation or your IT/IS 
department on how to configure your user settings to include install privileges.
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Chapter 1: Getting Started & Configuring CPR+ Palm
 Using the Sync Interfaces
Follow the steps below to configure the amount of data that will be synced with 
CPR+ Palm and the PDA.

With the CPR+ Palm Settings configured, the next step is to install the CPR+ 
Palm module onto the PDA and then upload the CPR+ data that was just 
configured.

Step Action

1 Click the CPR+ Palm Settings tab. (The Personal Settings section 
appears.)

2 While on this screen, configure the following six settings:
• In the first field, enter the number of Delivery Tickets that will be 

transferred to the PDA that are no more than XXX days old (up to 
999 days).

• In the second field, enter the number of the most recent confirmed 
Delivery Tickets per patient that will be transferred (up to 9).

• In the third field, enter the number of the most recent Progress 
Notes per Patient that will be transferred (up to 9).

• In the fourth field, enter the number of Verbal Orders per patient 
that will be transferred (up to 9).

• In the fifth field, enter the number of Standard Plan of Treatment 
Orders per patient that will be transferred (up to 9).

• Sync the type of orders to the PDA that are flagged as Primary, 
Ancillary, or Both.
CPR+ Palm User Guide 13



Chapter 1: Getting Started & Configuring CPR+ Palm
 Installing CPR+ Palm on a PDA
Installing CPR+ Palm 
on a PDA

This section details how to install CPR+ Palm to a Windows Mobile PDA and a 
Palm OS PDA. For the Palm OS version, refer to the “Using HotSync & a Palm OS 
PDA” section on page 16.

Using ActiveSync & 
a Windows Mobile 
PDA

Before starting the ActiveSync client, make sure that the ActiveSync software is 
installed and the PocketPC or Windows Mobile PDA is linked to the workstation with 
a cable or cradle. Before syncing with CPR+, initiate a test sync with the default 
ActiveSync software settings and the PDA to make sure that everything is working 
properly.

ActiveSync Icon

Once ActiveSync is working correctly and connected to the PDA, the next step is to 
install CPR+ Palm and sync the data.

Step Action

1 Select the ActiveSync with CPR+ option from the File drop-down menu. 
(CPR+ will search for the handheld device.)

2 Once the PDA is located and the install button is enabled, click the CPR+ 
Palm Settings tab on the ActiveSync Interface screen and then click the 
Install CPR+ Palm button.

3 CPR+ displays a prompt about installing the module on the PDA.
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Chapter 1: Getting Started & Configuring CPR+ Palm
 Installing CPR+ Palm on a PDA
4 Click the Install button on the prompt screen. (CPR+ begins to install the 
software to the PDA and displays a progress bar in CPR+.) The sync time 
will vary based on a number of factors:

• How the settings are configured.
• How much data is in CPR+.
• The speed of the PDA’s processor.

If this is a first time install, the runtime software will be installed on the PDA 
and a message box will appear in CPR+. Click OK if the runtimes installed 
successfully.

5 Once the module is installed, CPR+ begins to sync the data stored in the 
database based on the configured settings. This may take several minutes 
based on the amount of data being transferred to the device.

6 When the sync is finished, the CPR+ Palm login screen appears on the PDA.

During the sync, CPR+ Palm receives only active, pending, and on-hold 
patient data. Sync times can be reduced by keeping these statuses updated 
in CPR+.

Step Action
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Chapter 1: Getting Started & Configuring CPR+ Palm
 Installing CPR+ Palm on a PDA
CPR+ Palm and the associated CPR+ data is now installed successfully on the 
Windows Mobile PDA. You are now ready to move on to “Cloning CPR+ Palm onto 
Other PDAs” section on page 18.

Using HotSync & a 
Palm OS PDA

Before starting the HotSync client, make sure that the HotSync software is installed 
and the Palm OS PDA is linked to the workstation with a cable or cradle.

Before syncing with CPR+, initiate a test sync with the HotSync software. Correct 
any sync problems with HotSync before installing the CPR+ Palm module. A 
successful sync without errors would qualify.

HotSync Icon

Once HotSync is working correctly, follow the steps below to install CPR+ Palm.

Step Action

1 Select the HotSync with CPR+ option from the File drop-down menu.

2 With the device connected, click the CPR+ Palm Settings tab on the 
HotSync Interface screen and then click the Install CPR+ Palm button.

3 CPR+ displays a prompt about installing the module on the PDA.

4 Click the Install button on the prompt screen. (CPR+ displays another 
prompt about waiting for HotSync.)
16 CPR+ Palm User Guide



Chapter 1: Getting Started & Configuring CPR+ Palm
 Installing CPR+ Palm on a PDA
With the CPR+ Palm application successfully installed, the next step is to sync the 
data.

5 Press the HotSync button on the handheld’s cradle or from the HotSync 
application on the device to begin the installation of CPR+ Palm. (A 
HotSync Progress screen appears with a status of the installation.)

6 With a successful sync, the Palm OS device will show the “HotSync operation 
complete” at the top of the HotSync screen.

Step Action

1 Open the CPR+ HotSync Interface from the File drop-down menu (if it’s not 
already open).

2 Click the HotSync Settings tab.

3 With the HotSync Settings tab selected and the device connected to the 
workstation, click the HotSync button on the cradle or from the HotSync 
application on the device. 

4 CPR+ will transfer the data to the PDA. (CPR+ displays a progress bar in 
the HotSync Interface screen.) The sync time will vary based on a number of 
factors:

• How the settings are configured.
• How much data is in CPR+.
• The speed of the PDA’s processor.

Step Action
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Chapter 1: Getting Started & Configuring CPR+ Palm
 Cloning CPR+ Palm onto Other PDAs
CPR+ Palm and the associated CPR+ data is now installed successfully on the 
Palm OS PDA.

Cloning CPR+ Palm 
onto Other PDAs

After CPR+ has synced once for the day, CPR+ display an icon next to the 
Synchronize CPR+ Palm checkbox. This is the CPR+ Palm Cloning feature.

Figure 1-4)  
CPR+ Palm Cloning 
Icon

5 With a successful data sync, the Palm OS device will show the “HotSync 
operation complete” at the top of the HotSync screen.

During the sync, CPR+ Palm receives only active, pending, and on-hold 
patient data. Sync times can be reduced by keeping these statuses updated 
in CPR+.

6 On the Palm OS device, locate CPR+ Palm on the PDA Desktop and then 
tap the CPR+ Palm icon to start the application. (The Login screen is 
displayed.)

Step Action
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Chapter 1: Getting Started & Configuring CPR+ Palm
 Cloning CPR+ Palm onto Other PDAs
By clicking this icon, a copy of the same data from the first sync can be made to 
additional CPR+ Palm devices of the same OS. This may be slightly faster than a 
full sync and will allow every CPR+ Palm user the ability to work with the same 
data.

In order for this feature to work, a full sync must be created so that it can be 
cloned to other PDAs. This is not an alternate way to install CPR+ Palm. 

Remember that a valid license and previous installation of CPR+ Palm is required 
for each PDA to be cloned.
CPR+ Palm User Guide 19





 Chapter  2 Navigating Menus & Accessing 
Data with CPR+ Palm
Now that the CPR+ Palm application is installed on the PDA and synced with the 
CPR+ data, it’s now time to see how to access this information.

Remember that this is the perfect tool for the on-call staff because they’ll be 
carrying the latest patient, physician, ancillary provider, and contact data in their 
pocket. No need to “whip-out” a laptop and log into the organization’s network to 
access this data.

After reading this chapter, you will be able to:

• Describe how to log into CPR+ Palm.

• Identify how to access patient information, physicians, ancillary providers 
and contacts.

• Describe how to enter Progress Notes.

• Describe how to resync CPR+ Palm for signatures, confirmed tickets, and 
new Progress Notes.
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Chapter 2: Navigating Menus & Accessing Data with CPR+ Palm
 Starting CPR+ Palm & Logging In
Starting CPR+ Palm 
& Logging In

From either your Palm OS or Windows Mobile PDA, launch the CPR+ Palm 
application by tapping the icon.

Figure 2-1)  
CPR+ Palm Icons

 

Once the application is loaded, you are presented with a login screen where you 
will need to select your name from the Name drop-down field and then type or write 
your password in the Password field. When done, tap the Login button.

Figure 2-2)  
CPR+ Palm Login 
Screens

 

After logging in, you’ll see the CPR+ Palm Main Menu. From here, you can access 
patients (active, pending, and on-hold), as well as physicians, ancillary providers, 
and contacts stored in the CPR+ Palm database.
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Chapter 2: Navigating Menus & Accessing Data with CPR+ Palm
 Accessing the Patient Menu
Figure 2-3)  
CPR+ Palm Main 
Menu

 

Accessing the 
Patient Menu

To access patients stored in CPR+ Palm, tap the Patient button on the Main 
Menu. A list of patients synced from the CPR+ database is displayed.

Figure 2-4)  
Select Patient Screen

 

There are several ways to access the patient’s information:

• Tap a letter at the top of the list to jump to the first person in the list with a 
last name that begins with the selected letter.

• Scroll through the list manually.

During the sync, CPR+ Palm receives only active, pending and on-hold patient 
data.
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Chapter 2: Navigating Menus & Accessing Data with CPR+ Palm
 Accessing the Patient Menu
• Type and write a letter to jump to that part of the list.

Once a patient is found, simply tap the patient’s name and the Patient’s Menu 
appears.

Figure 2-5)  
Patient Menu

 

The next part of this guide reviews each of these menu options, examples of the 
data shown on the screens, and how to add new Progress Notes (that would be 
uploaded back to CPR+ in a later sync).

Accessing the 
Patient’s 
Demographics

While on the Patient Menu, tap the Demographics button. (The first page of the 
Demographics screen appears.)

Figure 2-6)  
Patient Demographics 
(Screen 1)
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Chapter 2: Navigating Menus & Accessing Data with CPR+ Palm
 Accessing the Patient Menu
The first screen contains the Patient’s Address, Phone Numbers, Start of Care 
(SOC), DOB, Physicians (up to 2), and the Ancillary Providers.

Tap the magnifying glass icon next to a specific Physician or Provider to view 
additional information.

Figure 2-7)  
Physician Information

 

To view more patient demographic information tap the down arrow (on the Palm 
OS) or the right arrow (on the Windows Mobile OS) while on the patient’s 
Demographics screen.

Figure 2-8)  
Patient Demographics 
(Screen 2)

 

As a reminder when accessing information in CPR+ Palm, tap the back arrow 
icon on the lower left side of a screen to return to the previous screen.
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Chapter 2: Navigating Menus & Accessing Data with CPR+ Palm
 Accessing the Patient Menu
The second screen contains the Patient’s Status, Code Status, Assigned Company, 
and the first 3 active Insurance Providers with policy numbers.

To view additional patient demographic information tap the down arrow (on the 
Palm OS) or the right arrow (on the Windows Mobile OS).

Figure 2-9)  
Patient Demographics 
(Screen 3)

 

This screen displays a list of contacts associated with the selected patient. By 
tapping on a contact in the list at the top of the screen, more detailed information 
is displayed in the lower half of the screen.

To return back to the Patient Menu, tap the curved arrow icon in the lower left 
corner of the screen, or click the left arrow or up arrow icon to return to the 
previous screen.
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Chapter 2: Navigating Menus & Accessing Data with CPR+ Palm
 Accessing the Patient Menu
Accessing the 
Patient’s Medical 
Information

While on the Patient Menu, tap the Medical Information button. (The first page 
of the Medical Information screen appears.)

Figure 2-10)  
Medical Info (Screen 1)

 

The first screen of the patient’s Medical Info displays the patient’s Phone Number, 
Height, Weight, Drug Allergy (with additional info by tapping the magnifying 
glass icon), Diagnosis, Access, and Primary Physician (with additional info by 
tapping the magnifying glass icon).

To view more medical information tap the down arrow (on the Palm OS) or the 
right arrow (on the Windows Mobile OS) while on the patient’s Medical Info 
screen.

Figure 2-11)  
Medical Info (Screen 2)

 

The second screen of Medical Info displays up to 4 diagnoses.
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Chapter 2: Navigating Menus & Accessing Data with CPR+ Palm
 Accessing the Patient Menu
To return back to the Patient Menu, tap the curved arrow icon in the lower left 
corner of the screen.

Accessing the 
Patient’s 
Medication Profile

While on the Patient Menu, tap the Medication Profile button. (The Med Profile 
screen appears.)

Figure 2-12)  
Medication Profile 
Screen

 

This screen displays a list of the patient’s medications which includes the 
Medication Name, Start Date and Dose. All Active Medications in the patient’s 
CPR+ Medication Profile are synched to CPR+ Palm. Tapping a particular 
medication in the Med Profile displays that medication in full screen.

Figure 2-13)  
Med Detail Screen

 

The Med Details screen displays the Name, Medication, Start and Stop Dates, Rx 
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Chapter 2: Navigating Menus & Accessing Data with CPR+ Palm
 Accessing the Patient Menu
Type, Dose, Route, Frequency, Drug Class, Duration, Comments and if this 
medication is dispensed by your organization.

To return to the Patient Menu, tap the curved arrow icon twice in the lower left 
corner of the Med Detail screen.

Accessing the 
Patient’s Delivery/
Pickup Tickets

Up to nine of the most recent Delivery/Pickup Tickets in a patient’s record can be 
viewed in CPR+ Palm. In addition, patient signatures can be captured on Delivery 
Tickets or Pickup Tickets. (These tickets can be auto-confirmed upon 
synchronization with CPR+.)

From the Patient Menu, tap the Delivery/Pickup Tickets button on a Palm OS 
device or tap the Delivery Tickets button on a Windows Mobile device. (The 
Delivery Tickets screen appears.)

Figure 2-14)  
Delivery Ticket Screen

 

This screen shows the Ship to Address, the Ticket Number, the Delivery Date, the 
Rx Type and if the ticket has been confirmed. In the Conf (Confirmed) column,

• A T shows that the ticket is set to be confirmed.

• An F shows the ticket is in the CPR+ Delivery Ticket Confirmation File 
waiting to be confirmed. If a ticket is waiting for a confirmation, then a 
signature can be collected.

If the delivery was shipped via the UPS interface in CPR+, the UPS tracking 
number would be viewable by tapping on the UPS icon.

Use the PDA navigation buttons to scroll to the next Med Detail record if 
available.
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When selecting a ticket in the list, the Ticket Details screen is displayed.

Figure 2-15)  
Ticket Detail Screen

 

This screen displays the Ticket Number, Date, and each of the items listed on the 
ticket along with the quantities.

Capturing a 
Signature

When a ticket has the confirmation status of F and a delivery or pickup is made, a 
signature can be collected for later confirmation by tapping the Signature button 
on the Ticket Details screen. (The Signature screen appears.)

Figure 2-16)  
SIgnature Screen

 

The electronic signature will be linked to this ticket for viewing purposes. Once the 
signature is collected and the OK button is tapped, the ticket can not be signed for 
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 Accessing the Patient Menu
again and appears with a T in the ticket list.

Figure 2-17)  
Confirmed Ticket After 
Signature

 

To return to the Patient Menu, tap the curved arrow icon in the lower left corner 
of the Delivery Tickets screen.

Accessing the 
Patient’s 
Directions to 
Home

From the Patient Menu, tap the Directions to Home button to access the 
information on how to get to the patient’s place of residence.

Figure 2-18)  
Directions Screen

 

For more information on syncing signatures and confirmed tickets, refer to 
“Ticket Confirmation with Signatures” section on page 39.
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 Accessing the Patient Menu
This CPR+ Palm feature is ideal for field nurses or delivery drivers so that they 
have turn-by-turn directions to the patient’s home or place of service.

To return to the Patient Menu, tap the curved arrow icon in the lower left corner 
of the Directions screen.

Viewing the 
Patient’s Progress 
Notes

Up to nine of the most recent Progress Notes will sync to CPR+ Palm. From the 
Patient Menu, tap the Progress Notes button. (The Progress Notes screen 
appears.)

Figure 2-19)  
Progress Notes Screen

 

The Progress Notes are listed in order by date with the most recent note appearing 
at the top of the list. The individual’s name that logged the original note in CPR+ 
is also displayed. By tapping on a note in the list, the full progress note on that 
patient appears on the screen.

Use the PDA navigation buttons to scroll to the next Progress Note in the list if 
available.
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 Accessing the Patient Menu
Figure 2-20)  
Individual Progress 
Note

 

To return to the Progress Note screen, tap the curved arrow icon in the lower left 
corner.

Creating a New 
Progress Note

While on the Progress Notes screen, users have the ability to add an unlimited 
number of New Notes and upon return to the office they can sync the new note(s) 
back to CPR+. To add a new note for the selected patient, tap the Add New 
Note button on Palm OS devices or tap the Plus Sign in the Green Circle icon 
on Windows Mobile devices.

Figure 2-21)  
New Progress Note 
Screen

 

After entering the new note, tap the Save Note button to return to the Progress 
Notes list.

To return to the Patient Menu screen, tap the curved arrow icon in the lower left 
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corner of the Progress Note screen.

Accessing the 
Patient’s Physician 
Orders

Up to nine Standard Plan of Treatments and up to nine Verbal Orders will sync to 
CPR+ Palm. This screen displays the Order Type, and From and To dates for each 
order. From the Patient Menu, tap the Physician Orders button. (The Physician 
Orders screen appears.)

Figure 2-22)  
Physician Orders 
Screen

 

From this screen, you can view the individual orders by tapping one in the list. (The 
Order Details screen appears.)

Figure 2-23)  
Order Details Screen

 

Tap one of the lines on the screen to view more information for that specific Plan of 
Treatment or Verbal Order.
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To return to the Patient Menu screen, tap the curved arrow icon in the lower left 
corner of the Physician Orders screen.

Accessing the List 
of Physicians

This information is valuable for a field nurse or on-call pharmacist when they need 
to contact a physician regarding a patient. From the Main Menu, tap the 
Physicians button. (The Select Physician screen appears.)

Figure 2-24)  
Select Physician Screen

 

Simply tap the desired physician to go to the first screen of the Physician’s record.

Figure 2-25)  
Physician Information 
(Page 1)

 

CPR+ Palm displays the Name, Specialty, Organization, various phone numbers, 
and email. To view additional Physician information, tap the down arrow or right 
arrow icons.
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Figure 2-26)  
Physician Information 
(Page 2)

 

A second page of information consists of the Physician’s Address, UPIN #, Medicaid 
#, DEA #, and License #.

To return to the Main Menu, tap the curved arrow icon in the lower left corner of 
the Physicians screen.
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Accessing the List 
of Ancillary 
Providers

This information is valuable for a field nurse or on-call pharmacist when they need 
to contact a previous provider regarding a patient. From the Main Menu, tap the 
Ancillary Providers button. (The Select Ancillary Provider screen appears.)

Figure 2-27)  
Select Ancillary 
Provider Screen

 

Simply tap the desired provider to go to the Ancillary Provider record.

Figure 2-28)  
Ancillary Provider 
Screen

 

The Ancillary Provider screen shows the Organization Name, Contact, Phone and 
Fax Numbers, and Address.

To return to the Main Menu, tap the curved arrow icon in the lower left corner of 
the Ancillary Provider screen.
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Accessing the List 
of Contacts

This information is valuable for a field nurse or on-call pharmacist when they need 
to contact an employee/co-worker after hours. From the Main Menu, tap the 
Contacts button. (The Select Contact screen appears.)

Figure 2-29)  
Select Contact Screen

 

Simply tap the desired contact to go to the Contact’s record.

Figure 2-30)  
Contacts Screen

 

The Contacts screen displays the Name, Title, Address, email, and various phone 
numbers.

To return to the Main Menu, tap the curved arrow icon in the lower left corner of 
the Contacts screen.
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Syncing CPR+ Palm 
Data Back to CPR+

The next time the user syncs using either ActiveSync or HotSync, the following will 
happen:

• Any confirmed tickets with a signature are transferred back to CPR+

• Any new progress notes entered are transferred back to CPR+

• Any new information added to CPR+ since the last sync is uploaded to 
CPR+ Palm.

From the File drop-down menu, select either the ActiveSync or HotSync option 
(related to the PDA used). When the screen is displayed, make sure that the Attempt 
to confirm tickets that were signed electronically checkbox is marked.

Figure 2-31)  
ActiveSync Screen

After the sync occurs, CPR+ and CPR+ Palm are updated with the latest 
information. 

Ticket 
Confirmation with 
Signatures

When a ticket marked for confirmation is synched back to CPR+, the ticket will 
automatically confirm. If CPR+ encountered any change to the ticket or other 
problem, the ticket will not be confirmed and will remain in the confirmation list 
highlighted in red. These tickets must be fixed and confirmed manually.

The Delivery Ticket Confirmation File is located under the Things To Do Menu in 
CPR+.
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Figure 2-32)  
Delivery Ticket 
Confirmation Screen

Select the highlighted ticket and click the View Ticket (F3) button. (The Modify 
Delivery Ticket or Pickup Ticket screen appears.)

Figure 2-33)  
View Signature 
Window

To view the signature, click the Pen on Paper icon in the upper-right corner of the 
screen. (The View Signature screen appears.)

Review the ticket for any issues that need to be corrected manually. When 
corrected, click the Save (F2) button to return to the Delivery Ticket Confirmation 
screen. You can then:

• Confirm the ticket by clicking the Confirmation (Enter) button.

• Press the <Spacebar> key to confirm the ticket later in a batch 
confirmation.
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